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FM12 Workbench 

Preface 

Hi there FIFA MANAGER-Fans, 

We hereby want to wish you a lot of fun with our FM12 Workbench 

tutorial. The goal of this tutorial is to make the expansion of the FIFA 

MANAGER series as easy as possible. 

The term ‘’ID’’ will be used frequently in this document. This term 

represents a distinctive identification number which is used to for 

example find a particular club in any case. The actual name of the 

club is not distinctive and can change or will be written differently by 

different persons (“Manchester United”, “Man Utd.” etc.). Via the ID and 

the respective coordination of your files with those of other editors or fan sites full compatibility will 

be granted. 

If you should find any faults in this document, have any questions or if something is completely 

missing simply write a PM to Soeren or Gerald. We will then look at your proposal and we will try to 

inlcude it in one of the updates.  

But now we wish you a lot of fun and happy editing 

Greets 

Your FIFA MANAGER-Team 

 

Important: All information in this document is subject to correction and is realised at your own risk. 

We also point out that for certain areas partly advanced computer skills are necessary and the 

modification of files could also lead to a corruption or loss of data on your computer. If FIFA 

MANAGER should not start any more, a reinstallation of the game might help.  

If you haven’t downloaded this document from the official FIFA MANAGER website, please make sure 

that you have the newest version. Otherwise you might invest a lot of hard work and some things 

might work completely different in the meantime. 

If you publish your work please make sure you own all the rights. 
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Overview (Graphics) 

On the following pages you will find a list of the changeable graphical 

elements of FIFA MANAGER. 

The Unique IDs of clubs, players, countries and competitions can be activated 

in the options (open a savegame, click on Options -> Game Options) and will 

then be shown on the respective info screens. 

If tutorials are available, you can directly get there by 

clicking on YES. 

3D-Loading Screen 

Width: 1,920px Height: 1,200px Format: TGA with Alpha channel or BMP 

Tutorial available: No Reboot required: Yes 

File name: Your choice.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\3DMatch\LoadingScreen\1920x1200 

Additional Info: -/- 
  

Desktop Books 

Width: 
1,124px 
64px 

Height: 
1,004px 
64px 

Format: 
TGA with Alpha Channel / BMP 
24 Bit 

Tutorial available: YES Reboot required: Yes 

File name: Your choice.tga, Your choice _ico.tga 

Path: 
...\My Documents\FIFA MANAGER 12\Graphics\Desktop\Books\1124x1004 
...\My Documents\FIFA MANAGER 12\Graphics\Desktop\Books\64x64 

Additional Info: 

Two files are needed. Thereby, the large 1,124x1,004 graphic is the actual object, the smaller 
64x64 graphic is the preview picture.  
You can replace existing books (see tutorial) as well as implement a new one. If it is located in the 
respective folder, it will always be displayed in the game. 
Attention: The preview pictures are currently not used by the game, but could and should be 
created for the future. 

  

Desktop Backgrounds 

Width: 
1,920px 
64px 

Height: 
1,200px 
64px 

Format: 
TGA with Alpha Channel / BMP 
24 Bit 

Tutorial available: No Reboot required: Yes 

File name: Your choice.tga, your choice_ico.tga 

Path: 
...\My Documents\FIFA MANAGER 12\Graphics\Desktop\Backgrounds\1920x1200 
...\My Documents\FIFA MANAGER 12\Graphics\Desktop\Backgrounds\64x64 

Additional Info: 
Two files are needed. Thereby, the large 1,920x1,200 graphic is the actual object, the smaller 
64x64 graphic is the preview picture. 

  

Desktop Objects 

Width: 
512px 
64px 

Height: 
512px 
64px 

Format: 
TGA with Alpha Channel / BMP 
24 Bit 

Tutorial available: YES Reboot required: Yes 

File name: Your choice.tga, your choice_ico.tga 

Path: 
...\My Documents\FIFA MANAGER 12\Graphics\Desktop\Objects\512x512 
...\My Documents\FIFA MANAGER 12\Graphics\Desktop\Objects\64x64 

Additional Info: 
Two files are needed. Thereby, the large 512x512 graphic is the actual object, the smaller 64x64 
graphic is the preview picture. 
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Family Pictures 

Width: 160px Height: 160px Format: TGA with Alpha Channel 

Tutorial available: YES Reboot required: New savegame needed 

File name: GenderContinentAgegroup_XX.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Portraits\Family\160x160 

Additional Info: 
The complete list of all replaceable pictures can be found further below in this document. 
Furthermore, new pictures can be added which is also explained there. 

  

Fan Banners and Flags 

Width: 128px Height: 64px Format: TGA with Alpha Channel 

Tutorial available: No Reboot required: Yes 

File name: 

bna.tga -> Fan Banner 
bnb.tga -> Fan Banner 
bnc.tga -> Fan Banner 
fla.tga -> Flag 
flb.tga -> Flag 
flc.tga -> Flag 
lga.tga -> Logo Banner (Corner Flag) 
lgb.tga -> Logo Banner (Corner Flag) 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\3DMatch\Banners\UNIQUE TEAM ID 

Additional Info: *** The logo banners are currently not used. *** 
  

Hall of Fame 

Width: 160px Height: 160px Format: TGA with Alpha Channel 

Tutorial available: No Reboot required: Yes 

File name: UniqueTeamId_LastnameFn_ShirtNo_Birthday.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Portraits\PictureHallOfFame\160x160 

Additional Info: 
Fn = First two letters of the first name; Birthday in the format ddmmyyyy (e.g. 25121979 for 
25.12.1979); Shirt number has to be without leading zeros (1, 2, 3, ..., 9, 10, 11, 12...) 
Example: 000E000F_BestGe_11_22051945.tga 

  

Background Picture for the Editor 

Width: 1024px Height: 768px Format: BMP 24 Bit  

Tutorial available: Yes Reboot required: Editor must be restarted 

File name: EdManager.bmp 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Skins\Editor\1024x768 

Additional Info: -/-  
  

Manager Pictures (other Managers) 

Width: 160px Height: 160px Format: TGA with Alpha Channel 

Tutorial available: No Reboot required: Yes 

File name: LastnameFnDDMMYYYY.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Portraits\Staff\160x160 

Additional Info: 
Fn = First name; DDMMYYYY = Date of Birth (e.g. 25121979 for 25.12.1979) 
ä, ü, ö, é, è, etc. must be replaced by the respective standard letters.  
If the last name consists of more than one word, it must be written completely in lower case. 
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Manager Pictures (own picture) 

Width: 160px Height: 160px Format: TGA with Alpha Channel  

Tutorial available: No Reboot required: Yes 

File name: Your choice.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Portraits\Manager\160x160 

Additional Info: 
For the picture selection at game start. 
ä, ü, ö, é, è, etc. must be replaced by the respective standard letters.  
If the last name consists of more than one word, it must be written completely in lower case. 

  

Staff Pictures 

Width: 160px Height: 160px Format: TGA with Alpha Channel 

Tutorial available: No Reboot required: No 

File name: LastnameFnDDMMYYYY.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Portraits\Staff\160x160 

Additional Info: 
Fn = First name; DDMMYYYY = Date of Birth (e.g. 25121979 for 25.12.1979) 
ä, ü, ö, é, è, etc. must be replaced by the respective standard letters.  
If the last name consists of more than one word, it must be written completely in lower case. 

  

President Pictures 

Width: 160px Height: 160px Format: TGA with Alpha Channel  

Tutorial available: No Reboot required: No 

File name: LastnameFn.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Portraits\Staff\160x160 

Additional Info: 
Fn = First name; no Date of Birth needed here. 
ä, ü, ö, é, è, etc. must be replaced by the respective standard letters.  
If the last name consists of more than one word, it must be written completely in lower case. 

  

Personal Life: Stocks 

Width: 160px Height: 160px Format: BMP  

Tutorial available: No Reboot required: Yes 

File name: COMPANY NAME.bmp 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Stocks\160x160 

Additional Info: 

A custom file must be saved in the "Graphics\Stocks\" subdirectory of the game path in the 
custom directory. 
File structure: 
COMPANY NAME,FILE NAME,NUMBER OF SHARES,STARTING PRICE 
Example: 
xxx,xxx.bmp,60000000,35.50 
yyy,yyy.bmp,100000000,54.25 
In this directory the user must also save the logos of the companies. 

  

Personal Life (Car) 

Width: 820px Height: 510px Format: 
 TGA with Alpha Channel / BMP 24 
Bit 

Tutorial available: Yes Reboot required: Save game must be reloaded 

File Name: Your choice.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\PersonalItems\820x510 

Additional Info: The file “...\My Documents\FIFA MANAGER 12\Data\PersonalItems\Car.txt“ must be adjusted. 
  

Personal Life (Houses) 

Width: 820px Height: 510px Format: 
 TGA with Alpha Channel / BMP 24 
Bit 

Tutorial available: Yes Reboot required: Save game must be reloaded 
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File name: Your choice.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\PersonalItems\820x510 

Additional Info: 
The file “...\My Documents\FIFA MANAGER 12\Data\PersonalItems\House.txt“ must be 
adjusted. 

  

Personal Life (Luxury) 

Width: 820px Height: 510px Format: 
 TGA with Alpha Channel / BMP 24 
Bit 

Tutorial available: Yes Reboot required: Save game must be reloaded 

File name: Your choice.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\PersonalItems\820x510 

Additional Info: 
The file “...\My Documents\FIFA MANAGER 12\Data\PersonalItems\Luxury.txt“ must be 
adjusted. 

  

Referee Pictures 

Width: 160px Height: 160px Format: TGA with Alpha Channel  

Tutorial available: No Reboot required: No 

File name: LastnameFn.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Portraits\Referees\160x160 

Additional Info: 
Fn = First name; no Date of Birth needed here. 
ä, ü, ö, é, è, etc. must be replaced by the respective standard letters.  
If the last name consists of more than one word, it must be written completely in lower case. 

  

Player Pictures 

Width: 160px Height: 160px Format: TGA with Alpha Channel 

Tutorial available: Yes Reboot required: No 

File name: LastnameFnDDMMYYYY.tga or StagenameDDMMYYYY.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Portraits\Players\160x160 

Additional Info: 

Fn = First name; DDMMYYYY = Date of Birth (e.g. 25121979 for 25.12.1979). 
ä, ü, ö, é, è, etc. must be replaced by the respective standard letters.  
If the last name/ stage name consists of more than one word, it must be written completely in 
lower case. 

  

Player Pictures XXL 

Width: 418px Height: 336px Format: TGA with Alpha Channel 

Tutorial available: No Reboot required: No 

File name: LastnameFnDDMMYYYY.tga or PseudonymDDMMYYYY.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Portraits\Players\418x336 

Additional Info: 

Fn = First name; DDMMYYYY = Date of Birth (e.g. 25121979 for 25.12.1979). 
ä, ü, ö, é, è, etc. must be replaced by the respective standard letters.  
If the last name/ stage name consists of more than one word, it must be written completely in 
lower case. 

  

Stadiums (created in FIFA MANAGER) 

Width: - Height: - Format: STD 

Tutorial available: No Reboot required: Yes 

File name: 
UNIQUE TEAM ID.std -> Stadium of the first team 
UNIQUE TEAM ID-2.std -> Stadium of the second team 
UNIQUE TEAM ID-3.std -> Youth stadium 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\3DMatch\Stadiums\FM 

Additional Info: 
Your stadiums created in FIFA MANAGER 12 will be stored here. You can also save stadiums from 
your friends in this folder and then use them in the game. 
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Stadiums (from FIFA, older FIFA versions, not FIFA 11 or FIFA 12) 

Width: - Height: - Format: O / FSH 

Tutorial available: No Reboot required: Yes 

File name: 
sky_LIGHTINGTYPE.o 
texture_LIGHTINGTYPE.fsh 
stadium_LIGHTINGTYPE.o 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\3DMatch\Stadiums\FIFA\UNIQUE TEAM ID 

Additional Info: 

Each FIFA stadium (older version, not FIFA 11 or 12) consists of three files (see file name). For 
each stadium five different weather/lighting conditions are predefined. Hereby LIGHTINGTYPE 
represents a number from 0 to 4: 0 = Rain / 1 = Snow / 2 = Cloudily / 3 = Light Cloudily / 4 = Sun. 
All three files must of course have the same number. 
Example: sky_01.o   stadium_01.o   texture_01.fsh  
These files can be copied in the TEAM ID-folder and then be assigned to your club. 

  

Stadium Pictures 

Width: 
1,920px 
800px 
200px 

Height: 
1,200px 
600px 
150px 

Format: TGA with Alpha Channel or JPG 

Tutorial available: No Reboot required: No 

File name: UNIQUE TEAM ID.tga 

Path: 
...\My Documents\FIFA MANAGER 12\Graphics\Stadiums\1920x1200 
...\My Documents\FIFA MANAGER 12\Graphics\Stadiums\800x600 
...\My Documents\FIFA MANAGER 12\Graphics\Stadiums\200x150 

Additional Info: 
If the 1,920x1,200 resolution is not available, the integration will still pay off, since the highest 
resolution is only used in the background (Text Mode).  

  

City Pictures 

Width: 615px Height: 461px Format: 
TGA with Alpha Channel / BMP 24 
Bit / JPG 

Tutorial available: No Reboot required: No 

File name: UNIQUE TEAM ID.tga, Cityname.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Cities\615x461 

Additional Info: For Create a Club cities, city names can be added via cityname.tga. 
  

Sponsors: Adboard Sponsors 

Width: 512px Height: 85px Format: TGA with Alpha Channel 

Tutorial available: No Reboot required: Yes 

File name: Your choice.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Sponsors\512x85 

Additional Info: 
The file “...\My Documents\FIFA MANAGER 12\Data\Sponsors\Adboards.txt“ must be adjusted. 
*** Currently you still find this file in fmdata\eng (please change according to your game 
language). *** 

  

Sponsors: Primary Sponsors 

Width: 153px Height: 95px Format: TGA with Alpha Channel 

Tutorial available: No Reboot required: Yes 

File name: Your choice.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Sponsors\Primary\153x95 

Additional Info: 

The file “...\My Documents\FIFA MANAGER 12\Data\Sponsors\PrimarySponsors.txt“ must be 
adjusted. 
*** Currently you still find this file in fmdata\eng (please change according to your game 
language). *** 
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Tickets 

Width: 620px Height: 280px Format: TGA with Alpha Channel  

Tutorial available: No Reboot required: Yes 

File name: [ID]_[TROPHY|LOGO]_[ColorHex].tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Skins\Tickets\620x280 

Additional Info: 

There is a special folder "Graphics\Tickets" for tickets in the weekly progress (one per 
competition). Format: 620x280 tga. The filename must be of the following convention: 
[ID]_[TROPHY|LOGO]_[ColorHex].tga 
ID = Competition ID (see CompetitionBranding below) 
TROPHY|LOGO = Indicator whether the trophy or the competition logo is displayed. 
ColorHex = Text colour on the ticket (hexadecimal) 
 
CompetitionBranding: 
 
LEAGUE = 01 
LEAGUE_CUP = 04 
CHALLENGE_SHIELD = 05 
CONFERENCE_CUP = 06 
SUPERCUP = 07 
RELEGATION = 08 
CHAMPIONSLEAGUE = 09 
UEFA_CUP = 0A 

  

Training Camps 

Width: 295px Height: 221px Format: 
TGA with Alpha Channel / BMP 24 
Bit 

Tutorial available: Yes Reboot required: Yes 

File name: Your choice.tga, TC<ID>_booking.tga, TC<ID>_start.tga, TC<ID>_report.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\TrainingCamps\295x221 

Additional Info: 
The file “...\fmdata\Parameter File - Training Camp New.txt“ must be adjusted. 
There you can also find/ add the training camp ID. 

  

Kits 

Width: Template Height: Template Format: TGA with Alpha Channel 

Tutorial available: Yes Reboot required: Save game must be reloaded 

File name: 

UNIQUE TEAM ID_h.tga 
UNIQUE TEAM ID_a.tga 
UNIQUE TEAM ID_t.tga 
Countrycode.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\3DMatch\Kits 

Additional Info: 

The Country Code system is indicated in the ISO3-Standard (always the one with three letters). 
_t stands for “Third Kit“. 
For national squads, only one kit can be edited at the moment. 
The Template is located in …\FIFA MANAGER 12\user\kits. 
Both kit front and kit back have the texture size of 350x256. The aspect ratio however is 
displayed as 1:1 in the game. This means that before you work on these parts of the texture, they 
should be scaled from 350x256 to the size of 350x350 (So the real aspect ratio can be used), after 
that the finished front and back kit should be downscaled back to 350x256.  

  

  

http://en.wikipedia.org/wiki/ISO_3166-1
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Trophies 

Width: 

534px 
256px 
128px 
64px 
32px 

Height: 

423px 
256px 
128px 
64px 
32px 

Format: 
TGA with Alpha Channel / BMP 24 
Bit 

Tutorial available: No Reboot required: Yes 

File name: 

COMPETITION ID.tga 
COUNTRY ID:HEX2.tga 
<COUNTRY ID:HEX2><COMP_TYPE:HEX2>.tga 
<COUNTRY ID:HEX2><COMP_TYPE:HEX2>-<LEAGUE DEPTH>.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Trophies\295x221 

Additional Info: 

Competition ID = Unique ID of the competition. 
COUNTRY ID:HEX2 = Unique ID of the country in Hex-format. 
COM_TYPE:HEX2 = Competition type in Hex-format. 
LEAGUE DEPTH = League depth (00 for the first league, 01 for the second league, 02 for the third 
league). 

  

Badges (Clubs) 

Width: 

256px 
128px 
64px 
32px 

Height: 

256px 
128px 
64px 
32px 

Format: TGA with Alpha Channel 

Tutorial available: Yes Reboot required: Yes 

File name: UNIQUE TEAM ID.tga 

Path: 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Clubs\256x256 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Clubs\128x128 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Clubs\64x64 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Clubs\32x32 

Additional Info: 
Those are badges for real life clubs. 
There are no sub directories; the badges of all countries are directly put in the above mentioned 
directories. 

  

Badges (Generic) 

Width: 

256px 
128px 
64px 
32px 

Height: 

256px 
128px 
64px 
32px 

Format: TGA with Alpha Channel 

Tutorial available: Yes Reboot required: No 

File name: See list in appendix of this document 

Path: 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Generic\256x256 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Generic\128x128 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Generic\64x64 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Generic\32x32 

Additional Info: 
Here you can add badges which will be used for generic clubs. 
The complete list with all replaceable badges can be found in the appendix at the end of this 
document. 

  

Badges (Leagues) 

Width: 

256px 
128px 
64px 
32px 

Height: 

256px 
128px 
64px 
32px 

Format: TGA with Alpha Channel 

Tutorial available: Yes Reboot required: No 

File name: See list in appendix of this document 

Path: 
...\My Documents\FIFA MANAGER 12\Graphics\Badges\Leagues\256x256 
...\My Documents\FIFA MANAGER 12\Graphics\Badges\Leagues\128x128 
...\My Documents\FIFA MANAGER 12\Graphics\Badges\Leagues\64x64 
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...\My Documents\FIFA MANAGER 12\Graphics\Badges\Leagues\32x32 

Additional Info: 

These are league and competition badges. 
Competition ID = Unique ID of the competition 
COUNTRY ID:HEX2 = Unique ID of the country in Hex-format. 
COM_TYPE:HEX2 = Competition type in Hex-format. 
LEAGUE DEPTH = League depth (00 for the first league, 01 for the second league, 02 for the third 
league). 
 
The complete list with all replaceable badges can be found in the appendix at the end of this 
document. 

  

Website (Header) 

Width: 1024px Height: 126px Format: TGA with Alpha Channel  

Tutorial available: No Reboot required: Yes 

File name: Header_Countrycode.tga 

Path: 
...\My Documents\FIFA MANAGER 12\Graphics\Skins\Website\769x82 
*** The path is still 769x82! *** 

Additional Info: 
The Country Code system is indicated in the ISO3-Standard (always the one with three letters). 
It will only work for countries, who do not have an own website. Therefore excluded are 
Germany, England, France, Spain and Italy. 

  

Website Content Pictures 

Width: 640px Height: 480px Format: TGA with Alpha Channel  

Tutorial available: No Reboot required: Yes 

File name: [TEAM ID]_Number.tga 

Path: ...\My Documents\FIFA MANAGER 12\Graphics\Website\640x480 

Additional Info: 

These files must be stored in a new folder "Graphics\Website\640x480" in the user directory, 
under the unique club ID. Up to 10 pictures can be stored if the club ID is extended by a _number, 
for example 0015000A_5.jpg. 
 
A club file is shown with a probability of 50%, otherwise the stadium picture is used. 

 

 

  

http://en.wikipedia.org/wiki/ISO_3166-1
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Overview (Audio) 

On the following pages you will find a list of the changeable audio elements of FIFA MANAGER. 

Stadium Entry Music 

File format: 
MP3 or 
ASF 

  

File name: UNIQUE TEAM ID.mp3 oder .asf 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Music\StadiumEntry 

Additional Info: 
The entry music can be played in the club info’s stadium tab.  
During the 3D match the stadium entry will only be played at home games. 
Tutorial 

  

Fan Chants 

File format: WAV   

File name: UNIQUE TEAM ID_X.wav 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Chants 

Additional Info: The X in the file name stands for an ongoing number: 1, 2, 3, ...99, 100, 101, ... 
  

Manager Shouts 

File format: MP3   

File name: 

aa_x.mp3 -> All-out Attack! 
ba_x.mp3 -> Back! 
cs_x.mp3 -> Change sides! 
cl_x.mp3 -> Clear! 
sd_x.mp3 -> Slow down! 
cr_x.mp3 -> Crossing! 
dr_x.mp3 -> Dribbling! 
fr_x.mp3 -> Forward run! 
ho_x.mp3 -> Hoof it! 
ot_x.mp3 -> One-twos! 
ob_x.mp3 -> Out of bounds! 
pf_x.mp3 -> Pass forward! 
pl_x.mp3 -> Pass left! 
pr_x.mp3 -> Pass right! 
sh_x.mp3 -> Shoot! 
sq_x.mp3 -> Square it! 
ta_x.mp3 -> Tackling! 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Shouts 

Additional Info: The X in the file name stands for an ongoing number: 1, 2, 3, ...99, 100, 101, ... 
  

Menu.mp3 

File format: BNK   

File name: menu.bnk 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Samples 

Additional Info: 
*** For the in-game sound effects an internal EA tool is necessary, which is able to convert 
common music formats like MP3, WMA, WMV and Co. to *.bnk-Files. Therefore, these files can 
momentarily not be exchanged. *** 
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Mode.mp3 

File format: BNK   

File name: mode.bnk 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Samples 

Additional Info: 
*** For the ingame sound effects an internal EA tool is necessary, which is able to convert 
common music formats like MP3, WMA, WMV and Co. to *.bnk-Files. Therefore, these files can 
momentarily not be exchanged. *** 

  

Quiz Sounds 

File format: bnk   

File name: 

QuizRight.bnk 
QuizLoading.bnk 
QuizLost1.bnk 
QuizLost2.bnk 
Won.bnk 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Samples 

Additional Info: 

QuizLost1 will be played if defeated in the first three rounds (Laughter), QuizLost2 will be played 
if an honorable result has been achieved. 
*** For the ingame sound effects an internal EA tool is necessary, which is able to convert 
common music formats like MP3, WMA, WMV and Co. to *.bnk-Files. Therefore, these files can 
momentarily not be exchanged. *** 

  

SeasonNeg / SeasonPos 

File format: BNK   

File name: 

SeasonNeg1.bnk 
SeasonNeg2.bnk 
SeasonPos1.bnk 
SeasonPos1.bnk 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Samples 

Additional Info: 
*** For the ingame sound effects an internal EA tool is necessary, which is able to convert 
common music formats like MP3, WMA, WMV and Co. to *.bnk-Files. Therefore, these files can 
momentarily not be exchanged. *** 

  

Select Effects 

File format: BNK   

File name: 
Select1.bnk 
Select2.bnk 
Select3.bnk 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Samples 

Additional Info: 
*** For the ingame sound effects an internal EA tool is necessary, which is able to convert 
common music formats like MP3, WMA, WMV and Co. to *.bnk-Files. Therefore, these files can 
momentarily not be exchanged. *** 

  

Goal Music (for clubs and players) 

File format: 
MP3 oder 
ASF 

  

File name: LastnameFnDDMMYYYY.mp3 or .asf 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Music\Goal 

Additional Info: 

Format for clubs: 
UNIQUE TEAM ID.mp3 or .asf 
Format for players: 
Fn = First name ; DDMMYYYY = Date of Birth (e.g. 25121979 for 25.12.1979) 
The goal music will only be played at home games! 
Tutorial 
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Ups 

File format: BNK   

File name: 

UpsStart.bnk 
Ups1.bnk 
Ups2.bnk 
Ups3.bnk 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Samples 

Additional Info: 
*** For the ingame sound effects an internal EA tool is necessary, which is able to convert 
common music formats like MP3, WMA, WMV and Co. to *.bnk-Files. Therefore, these files can 
momentarily not be exchanged. *** 

  

Ups and Downs sound effects 

File format: BNK   

File name: 
UD1.bnk 
UD2.bnk 
UD3.bnk 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Samples 

Additional Info: 
*** For the ingame sound effects an internal EA tool is necessary, which is able to convert 
common music formats like MP3, WMA, WMV and Co. to *.bnk-Files. Therefore, these files can 
momentarily not be exchanged. *** 

  

Club Music 

File format: 
MP3 or 
ASF 

  

File name: UNIQUE TEAM ID.mp3 or .asf 

Path: ...\My Documents\FIFA MANAGER 12\Audio\Music\Club 

Additional Info: 
The Club Music is used for the match preview screen before the game day.  
Tutorial 
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Overview (Output) 

On the following pages you will find a list of all output folders of FIFA MANAGER. 

Formations 

File format: FMF   

File name: UserFormation.fmf 

Path: ...\My Documents\FIFA MANAGER 12\Data\Formations 

Additional Info: 
In this folder all collected formations will be saved as one single file. This way, you can easily 
forward all your tactics to a friend in one single file. 

  

Manager Biography 

File format: CSV   

File name: UNIQUE TEAM ID_X.csv 

Path: ...\My Documents\FIFA MANAGER 12\Data\Biography 

Additional Info: 
Here your manager biography will be saved, if desired. You can also view it outside the game. You 
can open the file with a spreadsheet application, e.g. from OpenOffice.org.  

  

Match Analysis Tool Data 

File format: MAT   

File name: - 

Path: ...\My Documents\FIFA MANAGER 12\Data\MAT 

Additional Info: 
In this folder, your collected MAT files are stored. That way you can e.g. persuade your friends of 
the effects of your tactical settings for the 3D match with your MAT statistics by sending them 
your MAT file.  

  

Savegames 

File format: EA   

File name: Your choice.ea 

Path: ...\My Documents\FIFA MANAGER 12\Data\SaveGames 

Additional Info: 
In this folder, your collected savegames are stored, which you can share with friends. If you paste 
a friend’s savegame in this folder, you can load it with your FIFA MANAGER. 

  

Statistics 

File format: CSV   

File name: Your choice.csv 

Path: ...\My Documents\FIFA MANAGER 12\Data\Statistics 

Additional Info: 
FIFA MANAGER offers a variety of statistics, which are tabularly listed. These can mostly be 
exported with one click and then be viewed outside the game. You can open the file with a 
spreadsheet application, e.g. from OpenOffice.org. 

  

Training Teeks 

File format: TRA   

File name: Your choice.tra 

Path: ...\My Documents\FIFA MANAGER 12\Data\Training\Weeks 

Additional Info: 
In this folder, your saved training sessions are stored. You can exchange those with your friends 
for example.  
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Overview (Data) 

On the following pages you will find a list of all changeable configuration elements of FIFA 

MANAGER. 

Historical Data 

File format: TXT   

File name: 

XX_X_X.txt 
The first number of the file name (e.g. 47), stands for the country code, the second number 
represents the league level (1

st
 division = 0; 2

nd
 division = 1 etc.). The third number can be used 

for multiple leagues on the same level. 

Path: ...\My Documents\FIFA MANAGER 12\Data\Historical 

Additional Info: Details can be found in the tutorial further below in this document. 
  

Interviews 

File format: TXT   

File name: ger.txt 

Path: ...\My Documents\FIFA MANAGER 12\Data\Interviews 

Additional Info: 

*** New questions can be added to the textfile, which will then be used in the game. However, 
the editor has not been released yet and there are no plans at the moment for doing so. If 
someone sends us a comprehensive text file with new questions we can discuss access to the 
editor. *** 

  

Matchday Comments 

File format: TXT   

File name: ger.txt 

Path: ...\My Documents\FIFA MANAGER 12\Data\MatchdayComments 

Additional Info: 

This feature is normally limited to the German version, since it contains gigantic amounts of text. 
New commentaries can be added to the text file, they are visible in the league after the game day 
We offer a respective editor for this purpose on our website. It is also possible to create a new 
file from scratch in order to also use this feature in different languages.  

  

Sponsors 

File format: TXT   

File name: 
PrimarySponsors.txt 
SecondarySponsors.txt 
AdBoardSponsors.txt 

Path: ...\My Documents\FIFA MANAGER 12\Data\Sponsors 

Additional Info: 
Text files for the various sponsor types are located in this folder. In the course of new graphical 
sponsors these must be adjusted.  

  

Towns 

File format: TXT   

File name: TownDataXX.txt 

Path: ...\My Documents\FIFA MANAGER 12\Data\Town 

Additional Info: 

Text files containing town names for the foundation of a CaC-team can be put in this folder.  
X being the Country ID. 
For Germany the file ought to be TownData21.txt.  
 
First number in the file: number of various club additions, like FC. 
These will then be described in detail. 
number 1: 1=e.g. VfB in front of City name (VfB Stuttgart), 0=FC after City name (Chelsea FC) 
number 2: article for the club name (see Database Editor, this depends on the language) 
last but one number: frequency in comparison to others 
Last number: team colour(0=random, 1=red/white, 2=black/white, 3=blue/white, 4=green/white) 
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The following number is a multiplier for the number of inhabitants. It should be left at 1.0. The 
next line is the amount of towns in the database.  
The single towns are composed of: town name, degree of latitude in minutes, degree of longitude 
in minutes, inhabitants, state. The two remaining digits are of no significance.  

  

Training Camps 

File format: TXT   

File name: Training Camps.txt 

Path: 
“...\fmdata\Parameter File - Training Camp New.txt” must be adjusted. 
You can also edit/see the ID of the training camp in this file. 

Additional Info: 
New training camps can be added in this file.  
Details can be found in the tutorial further below in this document 
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Tutorials 

Desktop-Books 

You can either replace existing books or add new ones. If the book is 

located in the respective directory, it will always be displayed in the game.  

If you want to add a new book to FIFA MANAGER, you have to consider the 

following aspects: 

 1. The new file must be in this path: 

...\My Documents\FIFA MANAGER 12\Graphics\Desktop\Books\1124x1004  

2. The new file must have an exact resolution of 1,124x1,004 pixels.  

3. The format must be .tga (32Bit). 

4. The active surface, where the content will later be depicted and which should preferably be white, 

starts 395 pixels from the upper margin and 110 pixels from the lower margin; the distance to the 

left margin should be 55 pixels, to the right it should be 53 pixels. 

5. Transparent areas can be marked with an Alpha channel. 

6. Each large book graphic requires an associated icon. 

7. The icon must be saved in the following folder: 

...\My Documents\FIFA MANAGER 12\Graphics\Desktop\Books\64x64  

8. The icon must have the same name as he original picture. Additionally, the appendix ”_ico“ must 

be added. 

Example:  MyBook_ico.tga  

9. The new file must have a resolution of exactly 64x64 pixels. 

10. The format must be .tga (32Bit). 

NOTICE:  The preview pictures/thumbnails aren’t used by the game momentarily, but they can 

and should be included so your work can be used by future updates and new versions 

of FIFA MANAGER. 
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Desktop Objects 

This tutorial deals with the creation of individual desktop objects, which we 

will explain by the example of a framed picture on your desktop.  

You will need:   

 PictureFrame.tif (available in the Download section of the FIFA 

MANAGER website) 

 Image processing software which is capable to read/edit files with 

several layers (e.g. GIMP) 

 Own picture 

Step 1 

In order to paste a picture of your choice in our picture frame, the file PictureFrame.tif must be 

opened first. 

Step 2 

The file contains eight layers, but only one must be replaced: “insert_picture here“  

Therefore, open your own picture and paste it in the PictureFrame.tif file.  

Step 3 

Now you should adjust the size of your picture so it fits perfectly beneath the frame.  

To achieve a perfect alignment, the picture has to be tilted by 14° counterclockwise. 

Step 4 

Now you see your picture in the picture frame. You only have to save it in the right format (.tga 

32Bit) and put it in the right folder (...My Documents\FIFA MANAGER 

12\Graphics\Desktop\Objects\512x512). 

Step 5 

Finally, a thumbnail must be saved. Simply reduce the existing graphic to 64x64 pixels. The thumbnail 

needs to be in .tga (32Bit) format and must be saved to the folder ...My Documents\FIFA MANAGER 

12\Graphics\Desktop\Objects\64x64\). 

That way even more additional pictures can be added. The picture frame itself is thereby not 

important.  

Merely the following criteria should be met: 

Resolution:  512x512 pixels and 64x64 pixels 

Format:  Targa (.tga) 

Bit depth:  8 Bit per channel, 4 channels -> 32 Bit 

http://www.gimp.org/
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Path large picture: ...\My Documents\FIFA MANAGER 12\Graphics\Desktop\Objects\512x512\ 

Path thumbnail: ...\My Documents\FIFA MANAGER 12\Graphics\Desktop\Objects\64x64\ 

Family Pictures 

The file naming consist of the following parts: 

[Gender][Continent]_[AgeGroup]_[Variant].tga 

Gender = male/female 

Continent = Europe/Asia/Africa 

AgeGroup =  0-1 --> 0 

2-3 --> 1 

4-6 --> 2 

7-10 --> 3 

11-14 --> 4 

12-19 --> 5 

20-29 --> 6 

30-39 --> 7 

40-49 --> 8 

50-59 --> 9 

60-... --> 10 

An example: 

 FemaleAsia00_0.tga 

 Altogether, there are 11 age groups. The allocation is as follows: 

If you create 11 pictures and you use the next free variant-ID (free for gender and Continent) and 

name the files respective to the scheme, you can also add new pictures. 

Example: We only have two variants of Female Asia (0 and 1), meaning the next ID would then 

be 2. So if you create the following files…  

FemaleAsia00_2.tga 

FemaleAsia01_2.tga 

FemaleAsia02_2.tga 
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FemaleAsia03_2.tga 

FemaleAsia04_2.tga 

FemaleAsia05_2.tga 

FemaleAsia06_2.tga 

FemaleAsia07_2.tga 

FemaleAsia08_2.tga 

FemaleAsia09_2.tga 

FemaleAsia10_2.tga 

... you will be able to select a new life partner at the start of the game. 

Therefore, simply save them to "...\My Documents\FIFA MANAGER 

12\Graphics\Portraits\Family\160x160".  

The table below shows all the available files. These files can be replaced by your own creations. 

MaleEurope00_0.tga MaleEurope00_1.tga MaleEurope00_2.tga 

MaleEurope01_0.tga MaleEurope01_1.tga MaleEurope01_2.tga 

MaleEurope02_0.tga MaleEurope02_1.tga MaleEurope02_2.tga 

MaleEurope03_0.tga MaleEurope03_1.tga MaleEurope03_2.tga 

MaleEurope04_0.tga MaleEurope04_1.tga MaleEurope04_2.tga 

MaleEurope05_0.tga MaleEurope05_1.tga MaleEurope05_2.tga 

MaleEurope06_0.tga MaleEurope06_1.tga MaleEurope06_2.tga 

MaleEurope07_0.tga MaleEurope07_1.tga MaleEurope07_2.tga 

MaleEurope08_0.tga MaleEurope08_1.tga MaleEurope08_2.tga 

MaleEurope09_0.tga MaleEurope09_1.tga MaleEurope09_2.tga 

MaleEurope10_0.tga MaleEurope10_1.tga MaleEurope10_2.tga 

FemaleAfrica00_0.tga FemaleAfrica00_1.tga  

FemaleAfrica01_0.tga FemaleAfrica01_1.tga  

FemaleAfrica02_0.tga FemaleAfrica02_1.tga  

FemaleAfrica03_0.tga FemaleAfrica03_1.tga  

FemaleAfrica04_0.tga FemaleAfrica04_1.tga  

FemaleAfrica05_0.tga FemaleAfrica05_1.tga  

FemaleAfrica06_0.tga FemaleAfrica06_1.tga  

FemaleAfrica07_0.tga FemaleAfrica07_1.tga  

FemaleAfrica08_0.tga FemaleAfrica08_1.tga  

FemaleAfrica09_0.tga FemaleAfrica09_1.tga  

FemaleAfrica10_0.tga FemaleAfrica10_1.tga  

FemaleAsia00_0.tga FemaleAsia00_1.tga  

FemaleAsia01_0.tga FemaleAsia01_1.tga  

FemaleAsia02_0.tga FemaleAsia02_1.tga  

FemaleAsia03_0.tga FemaleAsia03_1.tga  

FemaleAsia04_0.tga FemaleAsia04_1.tga  

FemaleAsia05_0.tga FemaleAsia05_1.tga  

FemaleAsia06_0.tga FemaleAsia06_1.tga  

FemaleAsia07_0.tga FemaleAsia07_1.tga  

FemaleAsia08_0.tga FemaleAsia08_1.tga  

FemaleAsia09_0.tga FemaleAsia09_1.tga  

FemaleAsia10_0.tga FemaleAsia10_1.tga  

FemaleEurope00_0.tga FemaleEurope00_1.tga FemaleEurope00_2.tga 

FemaleEurope01_0.tga FemaleEurope01_1.tga FemaleEurope01_2.tga 

FemaleEurope02_0.tga FemaleEurope02_1.tga FemaleEurope02_2.tga 

FemaleEurope03_0.tga FemaleEurope03_1.tga FemaleEurope03_2.tga 

FemaleEurope04_0.tga FemaleEurope04_1.tga FemaleEurope04_2.tga 

FemaleEurope05_0.tga FemaleEurope05_1.tga FemaleEurope05_2.tga 

FemaleEurope06_0.tga FemaleEurope06_1.tga FemaleEurope06_2.tga 
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FemaleEurope07_0.tga FemaleEurope07_1.tga FemaleEurope07_2.tga 

FemaleEurope08_0.tga FemaleEurope08_1.tga FemaleEurope08_2.tga 

FemaleEurope09_0.tga FemaleEurope09_1.tga FemaleEurope09_2.tga 

FemaleEurope10_0.tga FemaleEurope10_1.tga FemaleEurope10_2.tga 

Generic.tga   

MaleAfrica00_0.tga MaleAfrica00_1.tga  

MaleAfrica01_0.tga MaleAfrica01_1.tga  

MaleAfrica02_0.tga MaleAfrica02_1.tga  

MaleAfrica03_0.tga MaleAfrica03_1.tga  

MaleAfrica04_0.tga MaleAfrica04_1.tga  

MaleAfrica05_0.tga MaleAfrica05_1.tga  

MaleAfrica06_0.tga MaleAfrica06_1.tga  

MaleAfrica07_0.tga MaleAfrica07_1.tga  

MaleAfrica08_0.tga MaleAfrica08_1.tga  

MaleAfrica09_0.tga MaleAfrica09_1.tga  

MaleAfrica10_0.tga MaleAfrica10_1.tga  

MaleAsia00_0.tga MaleAsia00_1.tga  

MaleAsia01_0.tga MaleAsia01_1.tga  

MaleAsia02_0.tga MaleAsia02_1.tga  

MaleAsia03_0.tga MaleAsia03_1.tga  

MaleAsia04_0.tga MaleAsia04_1.tga  

MaleAsia05_0.tga MaleAsia05_1.tga  

MaleAsia06_0.tga MaleAsia06_1.tga  

MaleAsia07_0.tga MaleAsia07_1.tga  

MaleAsia08_0.tga MaleAsia08_1.tga  

MaleAsia09_0.tga MaleAsia09_1.tga  

MaleAsia10_0.tga MaleAsia10_1.tga  
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Integrate FIFA Stadiums 

If you have created your own stadium for FIFA (older version, not for FIFA 

11 or 12) you can also integrate it in FIFA MANAGER. Just copy the file 

to the following directory: 

...\My Documents\FIFA MANAGER 

12\Graphics\3Dmatch\Stadiums\FIFA\000d0004  

000d0004 being the team’s Unique-ID which can be found in the 

editor.  

The following files must be present:  

sky_x.o  

stadium_x.o  

texture_x.fsh  

Hereby x is 0, 1 or 3. This digit indicates the weather: 

0 rainy or overcast 

1 sunny 

3 night 

If one illumination source is not available, another one will be selected randomly. BUT if one file of a 

set is present, all other files must be present as well. Some stadiums also have additional optional 

files. 

Additional files (.tag, .coll, .sle) are momentarily not supported. 
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Historical Results 

If you are a fan of statistics, the historical results might be just the 

thing for you. Here you can add historical league results to single 

leagues. This tutorial will explain you in detail how to do that. 

First, open the editor which you find in the installation directory of 

FIFA MANAGER. In our example, we would like to fill the historical 

database with results from Switzerland. You will find these by 

clicking on Assistants -> Country List in the editor. 

 

A new window will appear where you can see the countries and their Country-IDs, Switzerland’s ID is 

47. 

 

Now you create a new text document in ...\My Documents\FIFA MANAGER 12\Data\Historical which 

you name “47_0_0”. The two digits in the file name (in this case 47) are the country number, the 

second digit is the league level (1st division= 0, 2nd division = 1 etc.). The third digit can be used for 

several leagues on the same level. 
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During the editing process you have to replace the clubs with the teams from the new country, 

number them and then add the Team-ID. 

//FC Basel 
1,002F0003 
//Young Boys Bern 
2,002F0001 

FC Basel’s Team ID can also be found in the editor. Select Switzerland as the country, right-click on 

the club FC Basel, where you select Edit Club Settings in the context menu.  
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A new window appears, where you can see the Unique Team-ID  

 

You now repeat these steps for every club you need for your season. It is best to look at an already 

existing file to understand the structure and the way the list is set up.  

Let’s summarize: We put together a fairly long list of clubs which we will need for at least one season 

(shown below in an abridged version): 

//FC Basel 
1,002F0003 
//Young Boys Bern 
2,002F0001 
//Servette Genf 
3,002F000A 
//FC Zürich 
4,002F0006 
//FC St. Gallen 
-TEAMS ENDSeason:1997/1998 
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At the end of the last club the line “-TEAMS END-“must be included! Afterwards comes the first 

season line, starting with “Season:1997/1998”  

1 
18,15,2,2 
3,5,2,2 
13,9,1,0 
4,17,1,0 
14,7,2,1 
1,8,2,1 
2 
8,14,3,0 
15,4,1,3 
7,5,2,2 
18,1,3,0 
17,13,2,2 
9,3,1,2 
3 
Etc. 

At first the respective matchday, then the matches: 

Number 1 – home team’s number (as assigned above) 
Number 2 - away team’s number (as assigned above) 
Number 3 – home goals scored in this game 
Number 4 – away goals scored in this game 

Once you completed a season you add a new line with the next season: 1998/1999. 

These are followed by the matchdays with the respective results as already explained.   



 

© 2011 Electronic Arts GmbH | All Rights Reserved | www.FIFA-MANAGER.com  Version 1.0 

 
page 29 of 52 

.de 

 

Background Picture for the Editor 

In FM10 you can personalize the editor by integrating your won 

wallpaper. 

Therefore copy your wallpaper (EdManager.bmp) to the directory 

...\My Documents\FIFA MANAGER 12\Graphics\Skins\Editor\1024x768. 

If you want to delete the background, simply delete it from the main 

directory. 

This tutorial shows you how to create an individual background for the 

editor with the image manipulation program GIMP. 

First, you have to start the program. Then you click on File -> Open. 

The next step is to open the picture you want to have as background for the editor. In our case it is a 

background picture from the Online Mode (Background.jpg). Now you select Open. 

http://www.gimp.org/
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You now have to scale the picture in order to meet the correct dimensions, therefore click on Image -

> Scale Image. 

 

A new window will open. Here you can adjust the dimensions, these must be Width: 1024px and 

Height: 768px. After you entered the correct values you proceed by clicking on Scale.  
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The picture now has the required dimensions, but it needs to be converted to the required format 

and it must be copied to the respective directory. Click on File->Save As. 

 

A new window will open. Here you have to adjust three things. The filename must be EdManager. In 

the next step click on the +- symbol next to the file browser where you choose a path. The correct 

path is ...\My Documents\FIFA MANAGER 12\Graphics\Skins\Editor\1024x768 
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Now you click on the +- symbol close to Select File Type and select Windows BMP Image as format. 

 

Then you press the Save button. Another screen will open where you select 24 bits R8 G8 B8. Hit 

Save again and you are done. 

 

You can now close the program and look at the result in the editor. 
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A little tip from our side: The background picture shouldn’t be too dark, otherwise the font in the 

editor will be hard to read afterwards (see image below).  
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Music 

A substantial part of FIFA MANAGER’s atmosphere is achieved through music which is integrated in 

many areas of the game. You are also able to implement your own .mp3 or .asf music files in various 

game areas. 

Club Entry Music 

You can select the club’s entry music directly in the game. To 

integrate music of other clubs you have to copy the mp3 file to the 

directory ...\My Documents\FIFA MANAGER 

12\Audio\Music\StadiumEntry and name it "[ClubID].mp3" or 

"[ClubID].asf". The music will then be played at this club’s home 

games. 

Goal Music for Individual Players 

A special goal music for an individual player has to be named as follows: 

LastnameFnDDMMYYYY.mp3 or .asf  

Abbreviations mean: 

Fn = First name ; DDMMYYYY = Date of Birth (e.g. 25121979 for 25.12.1979) 

The file must then be copied to the directory ...\My Documents\FIFA MANAGER 

12\Audio\Music\Goal. 

 A goal music can also be selected by users directly in the game. 

The goal music will only be played at home games! 

Goal Music for Whole Teams 

The same goes for the general goal music of a club. Copy a "[ClubID].mp3"- or "[ClubID].asf" file in 

the directory ...\My Documents\FIFA MANAGER 12\Audio\Music\Goal. 

The goal music will only be played at home games! 

Club Music 

Single Clubs can have their own music in the matchday preview screen. Simply copy a "[ClubID].mp3" 

or "[ClubID].asf" file in the directory ...\My Documents\FIFA MANAGER 12\Audio\Music\Club. 

Example: "000E000F.mp3" for Manchester United or "0028004C.mp3" for Rubin Kazan. You 

can find the Club IDs in the database editor. 
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Parameter Files 

Again and again people uttered the request to publish information 
concerning the parameter files. Unfortunately, many updates and 
patches of varying quality were available last year, so we simply 
couldn’t any longer figure out, whether a player in the forum is 
playing the game with or without such an extension. That is why 
an evaluation of the postings became practically impossible for us. 
In FIFA MANAGER, we therefore decided to move the parameter 
files into the code, which will prevent any chance of manipulation. 
 
In contrast, important parameter files for game extensions (like the 
training camps e.g.) will be explained in detail in the respective chapter. 
Those will remain both modifiable and extensible. 
 

Please accept our apologies for any inconvenience caused, but in the medium term all players will 

benefit from this decision. 

NOTE: This affects all parameter files, as long as they are not explicitly marked as modifiable. GPPs 

(Gameplay Patches) for the 3D match are still possible though.  
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Personal Life 

In order to make it possible to see created graphics in the game, 
additional files must be changed. 
 
Personal Items 
File: 
Change: 
 
Personal Cars 
File:  ...\My Documents\FIFA MANAGER 12\Data\PersonalItems\car.txt 
Change: Each newly added car must get its own line. 
 
  EA Mobile Car,50000,mobilecar.bmp,2005 
  Name of the object in the game, Price, name of the graphic, year of “invention” 
 

Personal Houses 
File:  ...\My Documents\FIFA MANAGER 12\Data\PersonalItems\house.txt 
Change: Each newly added house must get its own line. 
 
  Appartement,50000,appartement.bmp,2005  

Name of the object in the game, Price, name of the graphic, year of “invention” 
 

 
Personal Furnishing 
File:  ...\My Documents\FIFA MANAGER 12\Data\PersonalItems\furnishings.txt 
Change: Each newly added furnishing item must get its own line. 

 
Pool-Table,3000,pool.bmp,0,2005 
Name of the object in the game, Price, name of the graphic, value growth, year of 
“invention” 

 
Personal Luxury 
File:  ...\My Documents\FIFA MANAGER 12\Data\PersonalItems\luxury.txt 
Change: Each newly added furnishing item must get its own line. 
 

Golf equippment,5000,golf.bmp,0,2005 
Name of the object in the game, Price, name of the graphic, value growth, year of 
“invention” 
  

Important:  

The list must be sorted by the “year of invention” of the cars/houses/furnishing/luxury.  

Let’s assume you want a specific car to first appear in the year 2010, another one in 2020. To achieve 

this, the cars have to be second last and last in the list. If you are not considering this, the cars will 

get mixed up later in the game. 

At the end of each editing process you should always count the exact number of cars and adjust the 

first number at the very top of the list, so it matches the actual number of cars. If you neglect that 
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step, new cars might not be shown in the game. If you reduce the number of cars and the numbers 

don’t add up, in the worst case the game might even crash! 

The fourth value of luxury and furnishing stands for “value growth” of an object. If you implement 

new items, you should set a “1” if the item’s value growth is positive (realty etc.), or you set a “0” if 

the item’s value will rather decrease over time (useful for objects of utility).  

Scripts 

In future versions of this document we will offer hints and clues for the creation of script files. 

For the moment, we plan the following as next steps: 

- Allocation of cupalloc.txt into countries/competitions 

- Allocation of Country Files in 4 areas (script files, schedule, club, players) 
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Player Pictures 

Our thanks go out to FM Interaktiv and www.fm-zocker.de for the friendly permission to publish this 

tutorial in our workbench. 

In this chapter we want to present the program GIMP which is a very useful tool for the creation of 

player pictures. 

The most important tool for the creation and editing of player pictures is the eraser. This tool 

will continually accompany you during the process. You start by selecting a template. Here you 

should ensure that the picture has suitable size. The player’s head should preferably be big, the neck 

and if possible the shoulders should also be on the picture. Furthermore, make sure no hair is 

missing. 

The next step is trimming the picture. The chin must be 0,5-0,9 cm away from the bottom 

margin, the head or hair must be on the same height with the upper margin. Furthermore, 

width and height must be the same. The shirt should finish flush with both sides. 

Now comes the most important step: Use Layers -> Transparency -> Add Alpha Channel. Eventhough 

no visible change takes place, the background layer becomes transparent.  

Afterwards, right-click Filters -> Enhance -> Sharpen and set the value to about 70, depending on the 

particular picture.  

With the help of the magnifier function we zoom in the picture, so we can differentiate between the 

background and the actual picture (circa 1,000%). 

Now for the first time, the eraser comes into play. We use the eraser (size: 5) to get from one 

shoulder to the other, once around the whole picture. For ears and hairs you should use a smaller 

size (e.g. 3 or 1), since precision is what we strive for here. You can also try out the Fuzzy Select Tool 

in this step. 

http://www.fm-zocker.de/
http://www.gimp.org/
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In this procedure, precision is far more important than speed, since the more precise you work, the 

better the final result will look.  

After the whole background has been cleared, the picture 

must be scaled to 160x160 pixels. Right click on the picture 

and use Image -> Scale Image.  

Now we are almost there. Use Colors -> Brightness-Contrast 

and the other color options to change brightness, contrast, 

intensity or color levels. You can perform miracles with 

these adjustments! 

Few steps ahead. Right-click on the image and use Filters -> 

Light and Shadow -> Drop Shadow. 

The values must be : 

Offset X: 3 

Offset Y: 3 

Blur radius: 4 

Color: Black 

Opacity: 75 

Furthermore, uncheck the box Allow resizing. Now Use Layer -> Anchor Layer and you’re done.  

The final player picture now has the name “SchweinsteigerBa01081984.tga”. The format is 

FirstnameLnDDMMYYYY.tga, in our case Schweinsteiger suffices, since it is a stage name (like 

Ronaldinho, Zé Roberto etc.).  

The picture must be saved in:  

...\My Documents\FIFA MANAGER 12\Graphics\Portraits\Players\160x160 
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Player Kits in Create a Club (CaC) Mode 

You can design your own clubs shirts for the CaC mode as well. This 

however is a bit more complicated. 

In our example we select Brazil, their Country ID is 36 (see editor). As 

a consequence all teams from Brazil start with the Team ID 0036xxxx. 

Brazil consists of 43 teams in the editor (possibly more, if added 

further ones). Every country has about 5 additional lower division clubs, 

which are available for pre-season friendlies but are not in the editor.  

 

Your CaC Team would now have the ID 00360031 (ID 49, 43 teams + 5 lower divisions + your CaC-

team). So where does the number 31 come from? 31 is a number from the hexadecimal system, in 

which 49 = hexadecimal 31 (3*16 + 1*1 = 49). 

Now comes the trick: In order to avoid problems with the existing teams from the database, which 

we want to avoid at any costs, we mark the CaC clubs with a special number. Therefore change the 

second digit of the Team ID from 0 to 1. The correct Team ID would then be 01360031. 

Enjoy your self-created shirt! 

ID Explanation: 

The Country ID 54 is decimal ( 5*10 + 4 ). 36 is hexadecimal ( 3*16 + 6 ). 

If you want to convert from decimal to hexadecimal, simply calculate 54 / 16 = 3, the remainder is 6. 

Alternative: Use the Windows Calculator, switch to the scientific view and enter 54. Press F5 and the 

hexadecimal number will be shown. 
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Training Camps 

You can easily add your own training camps with photos to the game. 

You have to copy three pictures to the folder ...\My Documents\FIFA 

MANAGER 12\Graphics\TrainingCamps\295x221. The images must 

have an aspect ratio of 4:3. The maximum visible size is 300x225 

pixels, if they should be larger there is no negative effect. But if 

they are smaller, they will look pixilated. 

Every camp has three different pictures which can be used for 

different areas in the game: Booking, Start and Report. The pictures 

differ in their file names, e.g.: TC02_booking.bmp, TC02_start.bmp and 

TC02_report.bmp for Camp No. 2. If no Start or Report picture is available, the Booking picture will be 

used instead.  

The parameter file (Parameter File-Training Camp New.txt), containing the data for the training camp 

can be found here: 

Program Files\EA SPORTS\FIFA MANAGER 12\fmdata 

Parameter file structure:  

1. Camp’s number (ID)  
2. Country-ID (see editor)  
3. Latitude  
4. Longitude (see Editor)  
5. Town name  
6. Costs per day 
7. Team building modifier 
8. Main skill modifier  
9. Mental skill modifier  
10. Physical skill modifier 
11. Fitness modifier 
12. Tactical modifier  
13. Individual skills modifier 

14.-16. Picture names 

Example:  

20,21,3265,526,IDS_TC_020,2800,1,1,2,4,4,2,1,1,tc_Sylt.bmp,tc_Sylt.bmp,tc_Sylt.bmp 

This is training camp No. 20; 21 stands for Germany, followed by the coordinates, town name, price 

and effects on the team. The last three entries are the picture names. In this case, only on epicture is 

available. The allocation to the different continents (Europe, Asia etc.) will be accomplished 

automatically. 
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TPI Files 

TPI is an EA internal file format. The respective converter will not be published by us, it is therefore 

impossible to edit or add new files. 

Translations 

If you want to translate the game into another language, you will need a team of people, otherwise it 

will take a year or longer to translate the game. 

We recently created an INOFFICIAL tool for this process; the use of this program however is at your 

own risk. 

Please contact Soeren in the FIFA MANAGER forum if you are interested to start a translation project. 

User.INI 

User.INI is a file that shouldn’t be changed under normal circumstances. But there is one useful 

function, which we do not officially support however: 

WINDOWED=1 

The game can be played in windowed mode. 

All other parameters serve for troubleshooting of hardware problems. In this way for example videos 

can be turned off to eliminate them as a possible error source.  
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Badges (Club) 

You can add as many badges as you like to FIFA MANAGER.  

 

GIMP is one possible program which you can use to create badges.  

 

How-To-Do:  

 

1. Copy the desired picture by right-clicking it.  

 

2. Use File -> New to create a new picture. A window will open, where you click on the Advanced 

Options +- symbol, select Fill with: -> Transparency 

 

 

3. Now you paste your picture (Ctrl + V) and erase the background of the picture, so only the badge 

will be left. Do this with the Eraser or with the Fuzzy Select Tool!  

 

4. The picture must now be scaled:  

- 32x32 and save 

- 64x64 and save  

- 128x128 and save  

- 256x256 and save  

5. Name the files as follows: 

UNIQUE TEAM ID.tga (e.g. 000e0005.tga for Liverpool) 

6. Save them to the appropriate directories: 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Clubs\256x256 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Clubs\128x128 

http://www.gimp.org/
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...\My Documents\FIFA MANAGER 12\Graphics\Badges\Clubs\64x64 

...\My Documents\FIFA MANAGER 12\Graphics\Badges\Clubs\32x32 

Important:  The image quality in the editor might differ from the quality in the actual game. 

NOTICE: During the creation of the badge, don‘t just add the Alpha channel. The pictures must 

be copied to a transparent background. Otherwise a coloured background will be in 

the game, despite the Alpha channel.  

 

Badges (Generic) 

This is the complete list of generic badges. You can replace them with your own creations (see 

above). 

bl_ge.tga bl_ge_01.tga bl_ge_02.tga bl_ge_03.tga bl_ge_04.tga bl_ge_05.tga 

bl_ge_05a.tga bl_ge_06.tga bl_ge_06a.tga bl_ge_06b.tga bl_ge_06c.tga bl_ge_06d.tga 

bl_ge_06e.tga bl_ge_07.tga bl_ge_07a.tga bl_ge_08.tga bl_ge_08a.tga bl_ge_09.tga 

bl_ge_09a.tga bl_ge_09b.tga bl_ge_09c.tga bl_ge_10.tga bl_ge_10a.tga bl_ge_11.tga 

bl_ge_11a.tga bl_ge_12.tga bl_ge_12a.tga bl_ge_13.tga bl_ge_13a.tga bl_ge_14.tga 

bl_ge_14a.tga bl_ge_15.tga bl_ge_15a.tga bl_ge_16.tga bl_ge_16a.tga bl_ge_17.tga 

bl_ge_17a.tga bl_ge_17b.tga bl_ge_17c.tga bl_ge_17d.tga bl_ge_17e.tga bl_ge_18.tga 

bl_ge_18a.tga bl_ge_19.tga bl_ge_19a.tga bl_ge_20.tga bl_ge_20a.tga bl_ge_21.tga 

bl_ge_21a.tga bl_ge_22.tga bl_ge_22a.tga bl_ge_23.tga bl_ge_23a.tga bl_ge_24.tga 

bl_ge_24a.tga bl_ge_25.tga bl_ge_25a.tga bl_ge_26.tga bl_ge_26a.tga bl_gr.tga 

bl_gr_01.tga bl_gr_02.tga bl_gr_03.tga bl_gr_04.tga bl_gr_05.tga bl_gr_05a.tga 

bl_gr_06.tga bl_gr_06a.tga bl_gr_06b.tga bl_gr_06c.tga bl_gr_06d.tga bl_gr_06e.tga 

bl_gr_07.tga bl_gr_07a.tga bl_gr_08.tga bl_gr_08a.tga bl_gr_09.tga bl_gr_09a.tga 

bl_gr_09b.tga bl_gr_09c.tga bl_gr_10.tga bl_gr_10a.tga bl_gr_11.tga bl_gr_11a.tga 

bl_gr_12.tga bl_gr_12a.tga bl_gr_13.tga bl_gr_13a.tga bl_gr_14.tga bl_gr_14a.tga 

bl_gr_15.tga bl_gr_15a.tga bl_gr_16.tga bl_gr_16a.tga bl_gr_17.tga bl_gr_17a.tga 

bl_gr_17b.tga bl_gr_17c.tga bl_gr_17d.tga bl_gr_17e.tga bl_gr_18.tga bl_gr_18a.tga 

bl_gr_19.tga bl_gr_19a.tga bl_gr_20.tga bl_gr_20a.tga bl_gr_21.tga bl_gr_21a.tga 

bl_gr_22.tga bl_gr_22a.tga bl_gr_23.tga bl_gr_23a.tga bl_gr_24.tga bl_gr_24a.tga 

bl_gr_25.tga bl_gr_25a.tga bl_gr_26.tga bl_gr_26a.tga bl_ro.tga bl_ro_01.tga 

bl_ro_02.tga bl_ro_03.tga bl_ro_04.tga bl_ro_05.tga bl_ro_05a.tga bl_ro_06.tga 

bl_ro_06a.tga bl_ro_06b.tga bl_ro_06c.tga bl_ro_06d.tga bl_ro_06e.tga bl_ro_07.tga 

bl_ro_07a.tga bl_ro_08.tga bl_ro_08a.tga bl_ro_09.tga bl_ro_09a.tga bl_ro_09b.tga 

bl_ro_09c.tga bl_ro_10.tga bl_ro_10a.tga bl_ro_11.tga bl_ro_11a.tga bl_ro_12.tga 

bl_ro_12a.tga bl_ro_13.tga bl_ro_13a.tga bl_ro_14.tga bl_ro_14a.tga bl_ro_15.tga 

bl_ro_15a.tga bl_ro_16.tga bl_ro_16a.tga bl_ro_17.tga bl_ro_17a.tga bl_ro_17b.tga 

bl_ro_17c.tga bl_ro_17d.tga bl_ro_17e.tga bl_ro_18.tga bl_ro_18a.tga bl_ro_19.tga 

bl_ro_19a.tga bl_ro_20.tga bl_ro_20a.tga bl_ro_21.tga bl_ro_21a.tga bl_ro_22.tga 

bl_ro_22a.tga bl_ro_23.tga bl_ro_23a.tga bl_ro_24.tga bl_ro_24a.tga bl_ro_25.tga 

bl_ro_25a.tga bl_ro_26.tga bl_ro_26a.tga bl_sw.tga bl_sw_01.tga bl_sw_02.tga 

bl_sw_03.tga bl_sw_04.tga bl_sw_05.tga bl_sw_05a.tga bl_sw_06.tga bl_sw_06a.tga 

bl_sw_06b.tga bl_sw_06c.tga bl_sw_06d.tga bl_sw_06e.tga bl_sw_07.tga bl_sw_07a.tga 

bl_sw_08.tga bl_sw_08a.tga bl_sw_09.tga bl_sw_09a.tga bl_sw_09b.tga bl_sw_09c.tga 

bl_sw_10.tga bl_sw_10a.tga bl_sw_11.tga bl_sw_11a.tga bl_sw_12.tga bl_sw_12a.tga 

bl_sw_13.tga bl_sw_13a.tga bl_sw_14.tga bl_sw_14a.tga bl_sw_15.tga bl_sw_15a.tga 

bl_sw_16.tga bl_sw_16a.tga bl_sw_17.tga bl_sw_17a.tga bl_sw_17b.tga bl_sw_17c.tga 

bl_sw_17d.tga bl_sw_17e.tga bl_sw_18.tga bl_sw_18a.tga bl_sw_19.tga bl_sw_19a.tga 

bl_sw_20.tga bl_sw_20a.tga bl_sw_21.tga bl_sw_21a.tga bl_sw_22.tga bl_sw_22a.tga 

bl_sw_23.tga bl_sw_23a.tga bl_sw_24.tga bl_sw_24a.tga bl_sw_25.tga bl_sw_25a.tga 

bl_sw_26.tga bl_sw_26a.tga bl_ws.tga bl_ws_01.tga bl_ws_02.tga bl_ws_03.tga 

bl_ws_04.tga bl_ws_05.tga bl_ws_05a.tga bl_ws_06.tga bl_ws_06a.tga bl_ws_06b.tga 

bl_ws_06c.tga bl_ws_06d.tga bl_ws_06e.tga bl_ws_07.tga bl_ws_07a.tga bl_ws_08.tga 



 

© 2011 Electronic Arts GmbH | All Rights Reserved | www.FIFA-MANAGER.com  Version 1.0 

 
page 45 of 52 

.de 

 

bl_ws_08a.tga bl_ws_09.tga bl_ws_09a.tga bl_ws_09b.tga bl_ws_09c.tga bl_ws_10.tga 

bl_ws_10a.tga bl_ws_11.tga bl_ws_11a.tga bl_ws_12.tga bl_ws_12a.tga bl_ws_13.tga 

bl_ws_13a.tga bl_ws_14.tga bl_ws_14a.tga bl_ws_15.tga bl_ws_15a.tga bl_ws_16.tga 

bl_ws_16a.tga bl_ws_17.tga bl_ws_17a.tga bl_ws_17b.tga bl_ws_17c.tga bl_ws_17d.tga 

bl_ws_17e.tga bl_ws_18.tga bl_ws_18a.tga bl_ws_19.tga bl_ws_19a.tga bl_ws_20.tga 

bl_ws_20a.tga bl_ws_21.tga bl_ws_21a.tga bl_ws_22.tga bl_ws_22a.tga bl_ws_23.tga 

bl_ws_23a.tga bl_ws_24.tga bl_ws_24a.tga bl_ws_25.tga bl_ws_25a.tga bl_ws_26.tga 

bl_ws_26a.tga dro_hbl.tga dro_hbl_01.tga dro_hbl_02.tga dro_hbl_03.tga dro_hbl_04.tga 

dro_hbl_05.tga dro_hbl_05a.tga dro_hbl_06.tga dro_hbl_06a.tga dro_hbl_06b.tga dro_hbl_06c.tga 

dro_hbl_06d.tga dro_hbl_06e.tga dro_hbl_07.tga dro_hbl_07a.tga dro_hbl_08.tga dro_hbl_08a.tga 

dro_hbl_09.tga dro_hbl_09a.tga dro_hbl_09b.tga dro_hbl_09c.tga dro_hbl_10.tga dro_hbl_10a.tga 

dro_hbl_11.tga dro_hbl_11a.tga dro_hbl_12.tga dro_hbl_12a.tga dro_hbl_13.tga dro_hbl_13a.tga 

dro_hbl_14.tga dro_hbl_14a.tga dro_hbl_15.tga dro_hbl_15a.tga dro_hbl_16.tga dro_hbl_16a.tga 

dro_hbl_17.tga dro_hbl_17a.tga dro_hbl_17b.tga dro_hbl_17c.tga dro_hbl_17d.tga dro_hbl_17e.tga 

dro_hbl_18.tga dro_hbl_18a.tga dro_hbl_19.tga dro_hbl_19a.tga dro_hbl_20.tga dro_hbl_20a.tga 

dro_hbl_21.tga dro_hbl_21a.tga dro_hbl_22.tga dro_hbl_22a.tga dro_hbl_23.tga dro_hbl_23a.tga 

dro_hbl_24.tga dro_hbl_24a.tga dro_hbl_25.tga dro_hbl_25a.tga dro_hbl_26.tga dro_hbl_26a.tga 

dro_sw.tga dro_sw_01.tga dro_sw_02.tga dro_sw_03.tga dro_sw_04.tga dro_sw_05.tga 

dro_sw_05a.tga dro_sw_06.tga dro_sw_06a.tga dro_sw_06b.tga dro_sw_06c.tga dro_sw_06d.tga 

dro_sw_06e.tga dro_sw_07.tga dro_sw_07a.tga dro_sw_08.tga dro_sw_08a.tga dro_sw_09.tga 

dro_sw_09a.tga dro_sw_09b.tga dro_sw_09c.tga dro_sw_10.tga dro_sw_10a.tga dro_sw_11.tga 

dro_sw_11a.tga dro_sw_12.tga dro_sw_12a.tga dro_sw_13.tga dro_sw_13a.tga dro_sw_14.tga 

dro_sw_14a.tga dro_sw_15.tga dro_sw_15a.tga dro_sw_16.tga dro_sw_16a.tga dro_sw_17.tga 

dro_sw_17a.tga dro_sw_17b.tga dro_sw_17c.tga dro_sw_17d.tga dro_sw_17e.tga dro_sw_18.tga 

dro_sw_18a.tga dro_sw_19.tga dro_sw_19a.tga dro_sw_20.tga dro_sw_20a.tga dro_sw_21.tga 

dro_sw_21a.tga dro_sw_22.tga dro_sw_22a.tga dro_sw_23.tga dro_sw_23a.tga dro_sw_24.tga 

dro_sw_24a.tga dro_sw_25.tga dro_sw_25a.tga dro_sw_26.tga dro_sw_26a.tga dro_ws.tga 

dro_ws_01.tga dro_ws_02.tga dro_ws_03.tga dro_ws_04.tga dro_ws_05.tga dro_ws_05a.tga 

dro_ws_06.tga dro_ws_06a.tga dro_ws_06b.tga dro_ws_06c.tga dro_ws_06d.tga dro_ws_06e.tga 

dro_ws_07.tga dro_ws_07a.tga dro_ws_08.tga dro_ws_08a.tga dro_ws_09.tga dro_ws_09a.tga 

dro_ws_09b.tga dro_ws_09c.tga dro_ws_10.tga dro_ws_10a.tga dro_ws_11.tga dro_ws_11a.tga 

dro_ws_12.tga dro_ws_12a.tga dro_ws_13.tga dro_ws_13a.tga dro_ws_14.tga dro_ws_14a.tga 

dro_ws_15.tga dro_ws_15a.tga dro_ws_16.tga dro_ws_16a.tga dro_ws_17.tga dro_ws_17a.tga 

dro_ws_17b.tga dro_ws_17c.tga dro_ws_17d.tga dro_ws_17e.tga dro_ws_18.tga dro_ws_18a.tga 

dro_ws_19.tga dro_ws_19a.tga dro_ws_20.tga dro_ws_20a.tga dro_ws_21.tga dro_ws_21a.tga 

dro_ws_22.tga dro_ws_22a.tga dro_ws_23.tga dro_ws_23a.tga dro_ws_24.tga dro_ws_24a.tga 

dro_ws_25.tga dro_ws_25a.tga dro_ws_26.tga dro_ws_26a.tga ge_sw.tga ge_sw_01.tga 

ge_sw_02.tga ge_sw_03.tga ge_sw_04.tga ge_sw_05.tga ge_sw_05a.tga ge_sw_06.tga 

ge_sw_06a.tga ge_sw_06b.tga ge_sw_06c.tga ge_sw_06d.tga ge_sw_06e.tga ge_sw_07.tga 

ge_sw_07a.tga ge_sw_08.tga ge_sw_08a.tga ge_sw_09.tga ge_sw_09a.tga ge_sw_09b.tga 

ge_sw_09c.tga ge_sw_10.tga ge_sw_10a.tga ge_sw_11.tga ge_sw_11a.tga ge_sw_12.tga 

ge_sw_12a.tga ge_sw_13.tga ge_sw_13a.tga ge_sw_14.tga ge_sw_14a.tga ge_sw_15.tga 

ge_sw_15a.tga ge_sw_16.tga ge_sw_16a.tga ge_sw_17.tga ge_sw_17a.tga ge_sw_17b.tga 

ge_sw_17c.tga ge_sw_17d.tga ge_sw_17e.tga ge_sw_18.tga ge_sw_18a.tga ge_sw_19.tga 

ge_sw_19a.tga ge_sw_20.tga ge_sw_20a.tga ge_sw_21.tga ge_sw_21a.tga ge_sw_22.tga 

ge_sw_22a.tga ge_sw_23.tga ge_sw_23a.tga ge_sw_24.tga ge_sw_24a.tga ge_sw_25.tga 

ge_sw_25a.tga ge_sw_26.tga ge_sw_26a.tga ge_ws.tga ge_ws_01.tga ge_ws_02.tga 

ge_ws_03.tga ge_ws_04.tga ge_ws_05.tga ge_ws_05a.tga ge_ws_06.tga ge_ws_06a.tga 

ge_ws_06b.tga ge_ws_06c.tga ge_ws_06d.tga ge_ws_06e.tga ge_ws_07.tga ge_ws_07a.tga 

ge_ws_08.tga ge_ws_08a.tga ge_ws_09.tga ge_ws_09a.tga ge_ws_09b.tga ge_ws_09c.tga 

ge_ws_10.tga ge_ws_10a.tga ge_ws_11.tga ge_ws_11a.tga ge_ws_12.tga ge_ws_12a.tga 

ge_ws_13.tga ge_ws_13a.tga ge_ws_14.tga ge_ws_14a.tga ge_ws_15.tga ge_ws_15a.tga 

ge_ws_16.tga ge_ws_16a.tga ge_ws_17.tga ge_ws_17a.tga ge_ws_17b.tga ge_ws_17c.tga 

ge_ws_17d.tga ge_ws_17e.tga ge_ws_18.tga ge_ws_18a.tga ge_ws_19.tga ge_ws_19a.tga 

ge_ws_20.tga ge_ws_20a.tga ge_ws_21.tga ge_ws_21a.tga ge_ws_22.tga ge_ws_22a.tga 

ge_ws_23.tga ge_ws_23a.tga ge_ws_24.tga ge_ws_24a.tga ge_ws_25.tga ge_ws_25a.tga 

ge_ws_26.tga ge_ws_26a.tga gr_ge.tga gr_ge_01.tga gr_ge_02.tga gr_ge_03.tga 

gr_ge_04.tga gr_ge_05.tga gr_ge_05a.tga gr_ge_06.tga gr_ge_06a.tga gr_ge_06b.tga 

gr_ge_06c.tga gr_ge_06d.tga gr_ge_06e.tga gr_ge_07.tga gr_ge_07a.tga gr_ge_08.tga 

gr_ge_08a.tga gr_ge_09.tga gr_ge_09a.tga gr_ge_09b.tga gr_ge_09c.tga gr_ge_10.tga 

gr_ge_10a.tga gr_ge_11.tga gr_ge_11a.tga gr_ge_12.tga gr_ge_12a.tga gr_ge_13.tga 
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gr_ge_13a.tga gr_ge_14.tga gr_ge_14a.tga gr_ge_15.tga gr_ge_15a.tga gr_ge_16.tga 

gr_ge_16a.tga gr_ge_17.tga gr_ge_17a.tga gr_ge_17b.tga gr_ge_17c.tga gr_ge_17d.tga 

gr_ge_17e.tga gr_ge_18.tga gr_ge_18a.tga gr_ge_19.tga gr_ge_19a.tga gr_ge_20.tga 

gr_ge_20a.tga gr_ge_21.tga gr_ge_21a.tga gr_ge_22.tga gr_ge_22a.tga gr_ge_23.tga 

gr_ge_23a.tga gr_ge_24.tga gr_ge_24a.tga gr_ge_25.tga gr_ge_25a.tga gr_ge_26.tga 

gr_ge_26a.tga gr_ro.tga gr_ro_01.tga gr_ro_02.tga gr_ro_03.tga gr_ro_04.tga 

gr_ro_05.tga gr_ro_05a.tga gr_ro_06.tga gr_ro_06a.tga gr_ro_06b.tga gr_ro_06c.tga 

gr_ro_06d.tga gr_ro_06e.tga gr_ro_07.tga gr_ro_07a.tga gr_ro_08.tga gr_ro_08a.tga 

gr_ro_09.tga gr_ro_09a.tga gr_ro_09b.tga gr_ro_09c.tga gr_ro_10.tga gr_ro_10a.tga 

gr_ro_11.tga gr_ro_11a.tga gr_ro_12.tga gr_ro_12a.tga gr_ro_13.tga gr_ro_13a.tga 

gr_ro_14.tga gr_ro_14a.tga gr_ro_15.tga gr_ro_15a.tga gr_ro_16.tga gr_ro_16a.tga 

gr_ro_17.tga gr_ro_17a.tga gr_ro_17b.tga gr_ro_17c.tga gr_ro_17d.tga gr_ro_17e.tga 

gr_ro_18.tga gr_ro_18a.tga gr_ro_19.tga gr_ro_19a.tga gr_ro_20.tga gr_ro_20a.tga 

gr_ro_21.tga gr_ro_21a.tga gr_ro_22.tga gr_ro_22a.tga gr_ro_23.tga gr_ro_23a.tga 

gr_ro_24.tga gr_ro_24a.tga gr_ro_25.tga gr_ro_25a.tga gr_ro_26.tga gr_ro_26a.tga 

gr_sw.tga gr_sw_01.tga gr_sw_02.tga gr_sw_03.tga gr_sw_04.tga gr_sw_05.tga 

gr_sw_05a.tga gr_sw_06.tga gr_sw_06a.tga gr_sw_06b.tga gr_sw_06c.tga gr_sw_06d.tga 

gr_sw_06e.tga gr_sw_07.tga gr_sw_07a.tga gr_sw_08.tga gr_sw_08a.tga gr_sw_09.tga 

gr_sw_09a.tga gr_sw_09b.tga gr_sw_09c.tga gr_sw_10.tga gr_sw_10a.tga gr_sw_11.tga 

gr_sw_11a.tga gr_sw_12.tga gr_sw_12a.tga gr_sw_13.tga gr_sw_13a.tga gr_sw_14.tga 

gr_sw_14a.tga gr_sw_15.tga gr_sw_15a.tga gr_sw_16.tga gr_sw_16a.tga gr_sw_17.tga 

gr_sw_17a.tga gr_sw_17b.tga gr_sw_17c.tga gr_sw_17d.tga gr_sw_17e.tga gr_sw_18.tga 

gr_sw_18a.tga gr_sw_19.tga gr_sw_19a.tga gr_sw_20.tga gr_sw_20a.tga gr_sw_21.tga 

gr_sw_21a.tga gr_sw_22.tga gr_sw_22a.tga gr_sw_23.tga gr_sw_23a.tga gr_sw_24.tga 

gr_sw_24a.tga gr_sw_25.tga gr_sw_25a.tga gr_sw_26.tga gr_sw_26a.tga gr_ws.tga 

gr_ws_01.tga gr_ws_02.tga gr_ws_03.tga gr_ws_04.tga gr_ws_05.tga gr_ws_05a.tga 

gr_ws_06.tga gr_ws_06a.tga gr_ws_06b.tga gr_ws_06c.tga gr_ws_06d.tga gr_ws_06e.tga 

gr_ws_07.tga gr_ws_07a.tga gr_ws_08.tga gr_ws_08a.tga gr_ws_09.tga gr_ws_09a.tga 

gr_ws_09b.tga gr_ws_09c.tga gr_ws_10.tga gr_ws_10a.tga gr_ws_11.tga gr_ws_11a.tga 

gr_ws_12.tga gr_ws_12a.tga gr_ws_13.tga gr_ws_13a.tga gr_ws_14.tga gr_ws_14a.tga 

gr_ws_15.tga gr_ws_15a.tga gr_ws_16.tga gr_ws_16a.tga gr_ws_17.tga gr_ws_17a.tga 

gr_ws_17b.tga gr_ws_17c.tga gr_ws_17d.tga gr_ws_17e.tga gr_ws_18.tga gr_ws_18a.tga 

gr_ws_19.tga gr_ws_19a.tga gr_ws_20.tga gr_ws_20a.tga gr_ws_21.tga gr_ws_21a.tga 

gr_ws_22.tga gr_ws_22a.tga gr_ws_23.tga gr_ws_23a.tga gr_ws_24.tga gr_ws_24a.tga 

gr_ws_25.tga gr_ws_25a.tga gr_ws_26.tga gr_ws_26a.tga hbl_sw.tga hbl_sw_01.tga 

hbl_sw_02.tga hbl_sw_03.tga hbl_sw_04.tga hbl_sw_05.tga hbl_sw_05a.tga hbl_sw_06.tga 

hbl_sw_06a.tga hbl_sw_06b.tga hbl_sw_06c.tga hbl_sw_06d.tga hbl_sw_06e.tga hbl_sw_07.tga 

hbl_sw_07a.tga hbl_sw_08.tga hbl_sw_08a.tga hbl_sw_09.tga hbl_sw_09a.tga hbl_sw_09b.tga 

hbl_sw_09c.tga hbl_sw_10.tga hbl_sw_10a.tga hbl_sw_11.tga hbl_sw_11a.tga hbl_sw_12.tga 

hbl_sw_12a.tga hbl_sw_13.tga hbl_sw_13a.tga hbl_sw_14.tga hbl_sw_14a.tga hbl_sw_15.tga 

hbl_sw_15a.tga hbl_sw_16.tga hbl_sw_16a.tga hbl_sw_17.tga hbl_sw_17a.tga hbl_sw_17b.tga 

hbl_sw_17c.tga hbl_sw_17d.tga hbl_sw_17e.tga hbl_sw_18.tga hbl_sw_18a.tga hbl_sw_19.tga 

hbl_sw_19a.tga hbl_sw_20.tga hbl_sw_20a.tga hbl_sw_21.tga hbl_sw_21a.tga hbl_sw_22.tga 

hbl_sw_22a.tga hbl_sw_23.tga hbl_sw_23a.tga hbl_sw_24.tga hbl_sw_24a.tga hbl_sw_25.tga 

hbl_sw_25a.tga hbl_sw_26.tga hbl_sw_26a.tga hbl_ws.tga hbl_ws_01.tga hbl_ws_02.tga 

hbl_ws_03.tga hbl_ws_04.tga hbl_ws_05.tga hbl_ws_05a.tga hbl_ws_06.tga hbl_ws_06a.tga 

hbl_ws_06b.tga hbl_ws_06c.tga hbl_ws_06d.tga hbl_ws_06e.tga hbl_ws_07.tga hbl_ws_07a.tga 

hbl_ws_08.tga hbl_ws_08a.tga hbl_ws_09.tga hbl_ws_09a.tga hbl_ws_09b.tga hbl_ws_09c.tga 

hbl_ws_10.tga hbl_ws_10a.tga hbl_ws_11.tga hbl_ws_11a.tga hbl_ws_12.tga hbl_ws_12a.tga 

hbl_ws_13.tga hbl_ws_13a.tga hbl_ws_14.tga hbl_ws_14a.tga hbl_ws_15.tga hbl_ws_15a.tga 

hbl_ws_16.tga hbl_ws_16a.tga hbl_ws_17.tga hbl_ws_17a.tga hbl_ws_17b.tga hbl_ws_17c.tga 

hbl_ws_17d.tga hbl_ws_17e.tga hbl_ws_18.tga hbl_ws_18a.tga hbl_ws_19.tga hbl_ws_19a.tga 

hbl_ws_20.tga hbl_ws_20a.tga hbl_ws_21.tga hbl_ws_21a.tga hbl_ws_22.tga hbl_ws_22a.tga 

hbl_ws_23.tga hbl_ws_23a.tga hbl_ws_24.tga hbl_ws_24a.tga hbl_ws_25.tga hbl_ws_25a.tga 

hbl_ws_26.tga hbl_ws_26a.tga li_sw.tga li_sw_01.tga li_sw_02.tga li_sw_03.tga 

li_sw_04.tga li_sw_05.tga li_sw_05a.tga li_sw_06.tga li_sw_06a.tga li_sw_06b.tga 

li_sw_06c.tga li_sw_06d.tga li_sw_06e.tga li_sw_07.tga li_sw_07a.tga li_sw_08.tga 

li_sw_08a.tga li_sw_09.tga li_sw_09a.tga li_sw_09b.tga li_sw_09c.tga li_sw_10.tga 

li_sw_10a.tga li_sw_11.tga li_sw_11a.tga li_sw_12.tga li_sw_12a.tga li_sw_13.tga 

li_sw_13a.tga li_sw_14.tga li_sw_14a.tga li_sw_15.tga li_sw_15a.tga li_sw_16.tga 

li_sw_16a.tga li_sw_17.tga li_sw_17a.tga li_sw_17b.tga li_sw_17c.tga li_sw_17d.tga 
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li_sw_17e.tga li_sw_18.tga li_sw_18a.tga li_sw_19.tga li_sw_19a.tga li_sw_20.tga 

li_sw_20a.tga li_sw_21.tga li_sw_21a.tga li_sw_22.tga li_sw_22a.tga li_sw_23.tga 

li_sw_23a.tga li_sw_24.tga li_sw_24a.tga li_sw_25.tga li_sw_25a.tga li_sw_26.tga 

li_sw_26a.tga li_ws.tga li_ws_01.tga li_ws_02.tga li_ws_03.tga li_ws_04.tga 

li_ws_05.tga li_ws_05a.tga li_ws_06.tga li_ws_06a.tga li_ws_06b.tga li_ws_06c.tga 

li_ws_06d.tga li_ws_06e.tga li_ws_07.tga li_ws_07a.tga li_ws_08.tga li_ws_08a.tga 

li_ws_09.tga li_ws_09a.tga li_ws_09b.tga li_ws_09c.tga li_ws_10.tga li_ws_10a.tga 

li_ws_11.tga li_ws_11a.tga li_ws_12.tga li_ws_12a.tga li_ws_13.tga li_ws_13a.tga 

li_ws_14.tga li_ws_14a.tga li_ws_15.tga li_ws_15a.tga li_ws_16.tga li_ws_16a.tga 

li_ws_17.tga li_ws_17a.tga li_ws_17b.tga li_ws_17c.tga li_ws_17d.tga li_ws_17e.tga 

li_ws_18.tga li_ws_18a.tga li_ws_19.tga li_ws_19a.tga li_ws_20.tga li_ws_20a.tga 

li_ws_21.tga li_ws_21a.tga li_ws_22.tga li_ws_22a.tga li_ws_23.tga li_ws_23a.tga 

li_ws_24.tga li_ws_24a.tga li_ws_25.tga li_ws_25a.tga li_ws_26.tga li_ws_26a.tga 

or_sw.tga or_sw_01.tga or_sw_02.tga or_sw_03.tga or_sw_04.tga or_sw_05.tga 

or_sw_05a.tga or_sw_06.tga or_sw_06a.tga or_sw_06b.tga or_sw_06c.tga or_sw_06d.tga 

or_sw_06e.tga or_sw_07.tga or_sw_07a.tga or_sw_08.tga or_sw_08a.tga or_sw_09.tga 

or_sw_09a.tga or_sw_09b.tga or_sw_09c.tga or_sw_10.tga or_sw_10a.tga or_sw_11.tga 

or_sw_11a.tga or_sw_12.tga or_sw_12a.tga or_sw_13.tga or_sw_13a.tga or_sw_14.tga 

or_sw_14a.tga or_sw_15.tga or_sw_15a.tga or_sw_16.tga or_sw_16a.tga or_sw_17.tga 

or_sw_17a.tga or_sw_17b.tga or_sw_17c.tga or_sw_17d.tga or_sw_17e.tga or_sw_18.tga 

or_sw_18a.tga or_sw_19.tga or_sw_19a.tga or_sw_20.tga or_sw_20a.tga or_sw_21.tga 

or_sw_21a.tga or_sw_22.tga or_sw_22a.tga or_sw_23.tga or_sw_23a.tga or_sw_24.tga 

or_sw_24a.tga or_sw_25.tga or_sw_25a.tga or_sw_26.tga or_sw_26a.tga or_ws.tga 

or_ws_01.tga or_ws_02.tga or_ws_03.tga or_ws_04.tga or_ws_05.tga or_ws_05a.tga 

or_ws_06.tga or_ws_06a.tga or_ws_06b.tga or_ws_06c.tga or_ws_06d.tga or_ws_06e.tga 

or_ws_07.tga or_ws_07a.tga or_ws_08.tga or_ws_08a.tga or_ws_09.tga or_ws_09a.tga 

or_ws_09b.tga or_ws_09c.tga or_ws_10.tga or_ws_10a.tga or_ws_11.tga or_ws_11a.tga 

or_ws_12.tga or_ws_12a.tga or_ws_13.tga or_ws_13a.tga or_ws_14.tga or_ws_14a.tga 

or_ws_15.tga or_ws_15a.tga or_ws_16.tga or_ws_16a.tga or_ws_17.tga or_ws_17a.tga 

or_ws_17b.tga or_ws_17c.tga or_ws_17d.tga or_ws_17e.tga or_ws_18.tga or_ws_18a.tga 

or_ws_19.tga or_ws_19a.tga or_ws_20.tga or_ws_20a.tga or_ws_21.tga or_ws_21a.tga 

or_ws_22.tga or_ws_22a.tga or_ws_23.tga or_ws_23a.tga or_ws_24.tga or_ws_24a.tga 

or_ws_25.tga or_ws_25a.tga or_ws_26.tga or_ws_26a.tga ro_ge.tga ro_ge_01.tga 

ro_ge_02.tga ro_ge_03.tga ro_ge_04.tga ro_ge_05.tga ro_ge_05a.tga ro_ge_06.tga 

ro_ge_06a.tga ro_ge_06b.tga ro_ge_06c.tga ro_ge_06d.tga ro_ge_06e.tga ro_ge_07.tga 

ro_ge_07a.tga ro_ge_08.tga ro_ge_08a.tga ro_ge_09.tga ro_ge_09a.tga ro_ge_09b.tga 

ro_ge_09c.tga ro_ge_10.tga ro_ge_10a.tga ro_ge_11.tga ro_ge_11a.tga ro_ge_12.tga 

ro_ge_12a.tga ro_ge_13.tga ro_ge_13a.tga ro_ge_14.tga ro_ge_14a.tga ro_ge_15.tga 

ro_ge_15a.tga ro_ge_16.tga ro_ge_16a.tga ro_ge_17.tga ro_ge_17a.tga ro_ge_17b.tga 

ro_ge_17c.tga ro_ge_17d.tga ro_ge_17e.tga ro_ge_18.tga ro_ge_18a.tga ro_ge_19.tga 

ro_ge_19a.tga ro_ge_20.tga ro_ge_20a.tga ro_ge_21.tga ro_ge_21a.tga ro_ge_22.tga 

ro_ge_22a.tga ro_ge_23.tga ro_ge_23a.tga ro_ge_24.tga ro_ge_24a.tga ro_ge_25.tga 

ro_ge_25a.tga ro_ge_26.tga ro_ge_26a.tga ro_sw.tga ro_sw_01.tga ro_sw_02.tga 

ro_sw_03.tga ro_sw_04.tga ro_sw_05.tga ro_sw_05a.tga ro_sw_06.tga ro_sw_06a.tga 

ro_sw_06b.tga ro_sw_06c.tga ro_sw_06d.tga ro_sw_06e.tga ro_sw_07.tga ro_sw_07a.tga 

ro_sw_08.tga ro_sw_08a.tga ro_sw_09.tga ro_sw_09a.tga ro_sw_09b.tga ro_sw_09c.tga 

ro_sw_10.tga ro_sw_10a.tga ro_sw_11.tga ro_sw_11a.tga ro_sw_12.tga ro_sw_12a.tga 

ro_sw_13.tga ro_sw_13a.tga ro_sw_14.tga ro_sw_14a.tga ro_sw_15.tga ro_sw_15a.tga 

ro_sw_16.tga ro_sw_16a.tga ro_sw_17.tga ro_sw_17a.tga ro_sw_17b.tga ro_sw_17c.tga 

ro_sw_17d.tga ro_sw_17e.tga ro_sw_18.tga ro_sw_18a.tga ro_sw_19.tga ro_sw_19a.tga 

ro_sw_20.tga ro_sw_20a.tga ro_sw_21.tga ro_sw_21a.tga ro_sw_22.tga ro_sw_22a.tga 

ro_sw_23.tga ro_sw_23a.tga ro_sw_24.tga ro_sw_24a.tga ro_sw_25.tga ro_sw_25a.tga 

ro_sw_26.tga ro_sw_26a.tga ro_ws.tga ro_ws_01.tga ro_ws_02.tga ro_ws_03.tga 

ro_ws_04.tga ro_ws_05.tga ro_ws_05a.tga ro_ws_06.tga ro_ws_06a.tga ro_ws_06b.tga 

ro_ws_06c.tga ro_ws_06d.tga ro_ws_06e.tga ro_ws_07.tga ro_ws_07a.tga ro_ws_08.tga 

ro_ws_08a.tga ro_ws_09.tga ro_ws_09a.tga ro_ws_09b.tga ro_ws_09c.tga ro_ws_10.tga 

ro_ws_10a.tga ro_ws_11.tga ro_ws_11a.tga ro_ws_12.tga ro_ws_12a.tga ro_ws_13.tga 

ro_ws_13a.tga ro_ws_14.tga ro_ws_14a.tga ro_ws_15.tga ro_ws_15a.tga ro_ws_16.tga 

ro_ws_16a.tga ro_ws_17.tga ro_ws_17a.tga ro_ws_17b.tga ro_ws_17c.tga ro_ws_17d.tga 

ro_ws_17e.tga ro_ws_18.tga ro_ws_18a.tga ro_ws_19.tga ro_ws_19a.tga ro_ws_20.tga 

ro_ws_20a.tga ro_ws_21.tga ro_ws_21a.tga ro_ws_22.tga ro_ws_22a.tga ro_ws_23.tga 
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ro_ws_23a.tga ro_ws_24.tga ro_ws_24a.tga ro_ws_25.tga ro_ws_25a.tga ro_ws_26.tga 

ro_ws_26a.tga sw_ws.tga sw_ws_01.tga sw_ws_02.tga sw_ws_03.tga sw_ws_04.tga 

sw_ws_05.tga sw_ws_05a.tga sw_ws_06.tga sw_ws_06a.tga sw_ws_06b.tga sw_ws_06c.tga 

sw_ws_06d.tga sw_ws_06e.tga sw_ws_07.tga sw_ws_07a.tga sw_ws_08.tga sw_ws_08a.tga 

sw_ws_09.tga sw_ws_09a.tga sw_ws_09b.tga sw_ws_09c.tga sw_ws_10.tga sw_ws_10a.tga 

sw_ws_11.tga sw_ws_11a.tga sw_ws_12.tga sw_ws_12a.tga sw_ws_13.tga sw_ws_13a.tga 

sw_ws_14.tga sw_ws_14a.tga sw_ws_15.tga sw_ws_15a.tga sw_ws_16.tga sw_ws_16a.tga 

sw_ws_17.tga sw_ws_17a.tga sw_ws_17b.tga sw_ws_17c.tga sw_ws_17d.tga sw_ws_17e.tga 

sw_ws_18.tga sw_ws_18a.tga sw_ws_19.tga sw_ws_19a.tga sw_ws_20.tga sw_ws_20a.tga 

sw_ws_21.tga sw_ws_21a.tga sw_ws_22.tga sw_ws_22a.tga sw_ws_23.tga sw_ws_23a.tga 

sw_ws_24.tga sw_ws_24a.tga sw_ws_25.tga sw_ws_25a.tga sw_ws_26.tga sw_ws_26a.tga 
 

  



 

© 2011 Electronic Arts GmbH | All Rights Reserved | www.FIFA-MANAGER.com  Version 1.0 

 
page 49 of 52 

.de 

 

Badges (League Badges)  

Since it is rather difficult to correctly name the league badges, the 

following tutorial will provide some explanations as well as some 

examples. 

The images are named according to the competition-ID or parts of it. 

A competition-ID is an eight digit hexadecimal number, e.g. 15010001. 

This hexadecimal is composed as follows:  

15 01 0001 

cc tt nnnn 

Digit 1-2: Country ID hexadecimal 

Digit 3-4: Competition-Type hexadecimal  

Digit 5-8: Continuous number (1 division = 0000, 2nd division = 0001 etc.) 

 These are the various options how to name the badges: 

1. Complete Competition ID (e.g. 21010000.tga) => the image will be used only for this exact 

competition (first division of country 21).  

2. Country ID (2HEX) + Competition type (2HEX) – League depth (e.g. 21010000.tga) => the image will 

be used for the respective level of the respective competition of the respective country (e.g. for the 

first league in Germany). 

3. Country ID (2HEX) + Competition type (2HEX) (e.g. 2101.tga) => the image will be used for all 

competitions of the respective type in the selected country (e.g. first league and second league and 

third league etc.). 

4. Country ID (2HEX) (e.g. 21.tga) => the image will be used for all competitions of the indicated 

country. 

5. 00 + Competition-Typ (2HEX) – League depth (e.g. 00010000.tga) => The picture is used for all 

competitions (1st division) of the selected type for all countries. 

6. 00 + Competition-Typ (2HEX) (z.B. 0001.tga) => The picture is used for all competitions of the 

selected type in all countries and for all levels. 

The game checks in exactly this order, from the special options to the general options. If there are 

only the files… 

0001.tga 

15010001.tga  

…0001.tga would be used for every league in every country with the exception of the second division 

in Germany (because there is a complete ID for the German second division available). 
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In addition we have the following international competitions which use a 4-digit ID: 

Clubs: 

Europa Cup     F90A  

Champions Cup     F909  

International Super Cup     F90C  

FIFA Club WC     F90D  

South America Champions Cup    FA09  

South America Cup     FA0A  

North America Champions Cup    FB09  

African Champions Cup     FC09  

Asian Champions Cup     FD09  

Asian Cup     FD0A  

Oceanian Champions Cup        FE09  

National Teams: 

FIFA WC Qualif.     FF0F  

EC Qualif.   FF10  

WC     FF11  

EC     FF12  

FIFA U20 WC     FF1F  

Confed Cup     FF20  

South American Champ.     FF21  

  



 

© 2011 Electronic Arts GmbH | All Rights Reserved | www.FIFA-MANAGER.com  Version 1.0 

 
page 51 of 52 

.de 

 

Sponsor Images 

You can replace existing sponsor images for the 2D part of the game. The pictures will appear for 

your primary sponsor, in the sponsor pyramid and in the ad boards section. 

Step 1 

The images must exist in three different sizes in three different folders. 

Big 

...\My Documents\FIFA MANAGER 12\Graphics\Sponsors\96x96  

Small 

...\My Documents\FIFA MANAGER 12\Graphics\Sponsors\64x64 

Ad board 

...\My Documents\FIFA MANAGER 12\Graphics\Sponsors\512x85 

The file name format should be “Your choice.tga”. The files must have an alpha channel. 

Step 2 

Create a configuration file for your images. 

...\My Documents\FIFA MANAGER 12\Data\Sponsors\Parameter File – Sponsor List.txt 

BEGIN( COUNTRIES ) 

  

 BEGIN( #COUNTRY ) 

  //Country ID. If ID is 0, the following sponsors will be used in all countries that do not 

have a specific list of sponsors. 

  COUNTRY_ID = 0 

   

  //The lowest league level these sponsor can be used for. If this is set to 255, sponsors 

can be used for all league levels. 

  //League levels start with 0. 

  MAX_LEAGUE_LEVEL = 255 

 END 

  

 //Example: Germany 

 BEGIN( #COUNTRY ) 
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  COUNTRY_ID = 21 

  MAX_LEAGUE_LEVEL = 255 

   

  BEGIN( #SPONSOR ) 

   NAME = "Test1.tga" 

   PICTURE_BIG = "Test1.tga" 

   PICTURE_SMALL = "Test1.tga" 

   PICTURE_ADBOARD = "Test1.tga"    

  END 

 

  BEGIN( #SPONSOR ) 

   NAME = "Test2.tga" 

   PICTURE_BIG = "Test2.tga" 

   PICTURE_SMALL = "Test2.tga" 

   PICTURE_ADBOARD = "Test2.tga"    

  END 

 END 

END 

 


